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Software and System Tools and Applications

Standard Base Software

*Do not worry if you do not have all the software in the list.

Item | Software/Configuration/Plugin Word Latex Open Presentation
Editing Editing Document Editing
Editing

PDF EDITING

1 Adobe Acrobat Pro DC (if you have) v v v v

2 Barcode Font 4 4 v

3 Crop and Dotting Script for Acrobat 4 4 v
JACoWSetDot.js

4 Distiller Options 4 4 v 4
JACoW-12.joboptions

5 Enfocus PitStop Pro 2023 (30-day Trial) v v v v

6 Pitstop Media Box JACOW Media Box v v v
SYSTEM TOOLS ETC

7 Font Liberation Mono (Liberation Mono - .ttf) v v v v

8 Compression Tools 7-Zip/WinRAR/WinZip v v v v
WEB BROWSERS

9 Firefox/Chrome/Edge v v v v
DOCUMENT EDITORS

10 Microsoft Office (preferable version 2021) v

11 LibreOffice Writer/FreeOffice/OpenOffice v

12 Miktex v

13 TeXStudio v

14 Meld v

15 | Notepad++/WinEdit/EditPlus/GVIM v v v v
SLIDES TOOLS

16 | PowerPoint 365 v

17 Transparency Splitting (PPspliT) The zip file v
password is:“ppsplit”

18 Keynote (on mac systems) v

19 Mac Fonts v
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Finding Software Online

Item ‘ Download Locations

1 https://github.com/JACoW-org/AcrobatPitStopTools Repository of addins
2 https://github.com/JACoW-org/AcrobatPitStopTools/tree/master/barcode font (Right click on Raw, Save
Link As)
3 https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoWSetDot.js (Right click on Raw, Save
Link As)
4 https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoW- Do not worry if you cannot
12.joboptions file it. You can get it at the
team meeting.
6 https://github.com/JACoOW-
org/AcrobatPitStopTools/blob/master/JACOW%20Media%20Box.eal
7 https://www.freebestfonts.com/liberation-mono-font Download front site and
install on system
8 https://www.7-zip.org/ Download and Install
9 https://www.videolan.org/vic/ Download and Install
10 https://codecguide.com/download k-lite codec pack full.htm Download and Install
11 https://www.irfanview.com/64bit.htm Download and Install, also
install full plugins
12 https://camstudio.org/ Download and Install
13 https://virtualdub.org/ Download and Install
14 https://handbrake.fr, Download and Install
15 https://miktex.org/, https://miktex.org/howto/install-miktex Download and Install
16 https://notepad-plus-plus.org/downloads/ Download and Install
17 http://www.maxonthenet.altervista.org/ppsplit.php See instructions on
https://www.jacow.org/JTM2016/ProcessingTransparenciesEmbeddingAnimations JACoW.org
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https://github.com/JACoW-org/AcrobatPitStopTools
https://github.com/JACoW-org/AcrobatPitStopTools/tree/master/barcode_font
https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoWSetDot.js
https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoW-12.joboptions
https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoW-12.joboptions
https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoW%20Media%20Box.eal
https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoW%20Media%20Box.eal
https://www.freebestfonts.com/liberation-mono-font
https://miktex.org/
http://www.maxonthenet.altervista.org/ppsplit.php

Configuration Requirements and Notes

System Notes for Font Install

Adobe Acrobat Configure Acrobat, install script

Adobe Distiller Configure install JACOW-12.options, See below or Quick Guide

Word

Pitstop See Quick Guide

PowerPoint https://www.jacow.org/uploads/Editors/Slides Processing Manual V4
Quick Guide

1. Quick info for Acrobat/PitStop/PowerPoint script and tool
* JACoW-12.joboptions - JACOW JobOptions for Acrobat Distiller
* JACoW Media Box.eal - JACOW Crop Media Box Action List for Enfocus PitStop
* JACoWSetDot.js - JACOW Acrobat extension to assign dots+ on paper
* SplitAnimations.ppa - PowerPoint add-in to split animation when creating PDF
* SplitAnimations.ppt - "Workspace" for developing the SplitAnimations.ppa PowerPoint add-in
* barcode_font - TrueType font needed by JACoWSetDot.js to create the barcode onto papers

2. Instructions on how to use these files.
JobOptions:

copy the file into the Acrobat | Settings folder or import via Distiller via the "Settings | Add Adobe
PDF Settings..." menu entry.

Media Box Action List:

Import from PitStop "Run Action List" menu item by right-clicking on the "Local" folder and then
choosing "Import/Export..."

JACoWSetDot.js

First, install the "fre3o0f9x.ttf" font into the computer. The exact procedure may vary from platform
to platform. On OSX a warning could be given - just ignore it and proceed with the installation.

Copy "JACoWSetDot.js" into the Acrobat JavaScript extensions folder.
Also, this path could change for different operating system and Acrobat versions.
For Windows 7 and Acrobat 9 it defaults to
C:\Program Files\Adobe\Acrobat 9.0\Acrobat\Javascripts
and for Mac OS X 10.9 and Acrobat 11 it defaults to
~/Library/Application Support/Adobe/Acrobat/11.0/JavaScripts

(The directory may not exist - create it manually).
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https://www.jacow.org/uploads/Editors/Slides_Processing_Manual_V4

Also, remember to set the security option in Acrobat's preferences, otherwise the script won't
work. Go under Edit->Preferences->General->JavaScript and check the "Enable menu items
JavaScript execution privileges" option.

Moreover, in the "ldentity" tab be sure to have your (editor) name set,

REFERENCES:

- https://helpx.adobe.com/acrobat/kb/user-javascript-changes-10-1.html

- http://www.pdfscripting.com/public/111.cfm
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Software Configuration

Font Installation

Install Fonts Barcode, and Liberation Mono. Right Click on each font and select install.

[7] AUTHORS

[7] ChangeLog

[7] copviNG
LiberationMono-Bald ttf
LiberationMono-Boldltalic.tf

nuanaa

LiberationMone-Italic.ttf

A 1L R

5] Licensext P
[ README Print
B Share with Skype
Install

© Install forall users

@ Share
View online
Version history
Always keep on this device

Free up space

7-Zip >
CRCSHA >
) Convertto Adobe PDF
2, Convert to Adobe PDF and EMail
[&f Edit with Notepad++
EJ Scan with Microsoft Defender...
Open with >
Give access to >
B
. “ ”
Or select all font and click “Install for all users.
| [4 [ = | IPACJACOW Font
Home Share View
<« v A > ThisPC > Documents > JACoW Editor » IPACJACoW Font
A~
Name Date modified Type
# Quick access
B Desk 2 \  barcode_font 043010024 DAL Tesch ont file
ESKLO| .
P » LiberationMo Preview font file
» < = 3 @
!‘ Dawnioads A beerahonMoT Print font file
5 Documents * + _ LiberationMol font file
[&] Pictures » \  LiberationMo&, Install for all users bont file
Ad P
AcrobatPitStopTool ﬁ Convert to Adobe PDF
AcrobatPitStopTool g Edit with Notepad++
IPAC 22 IT Work &, EditPlus
OneDrive EH Scan with Microsoft Defender...
% Edit with Vim using tabpages
& Onechrve & Editwith single Vim
[ This PC 12 Share
& Network Give access to
B 8 Add to archive...
m Add to "IPAC JACoW Font.rar"
¥ Compress and email...
B% Compress to "IPAC JACOW Font.rar" and email
Send to
Cut
Copy
5items 5 items selected 451 KB

File
File
File
TrueType fon
TrueType fon
TrueType fon
TrueType fon
Text Docume
File

8KB
103 KB
116 KB
121 KB
106 KB

Search IPAC JACoW Font
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Adobe Acrobat DC Pro Configuration
1. Access Preferences Menu

Ctrl + K Access the Preference Menu

Adobe Acrobat Pro DC (64-bit)

File [ View E-Sign Certified PDF PitstopPro Window PitStop Pro Dashboard Help

Hg

Rotate Pages

Eind

Advanced Search

Check Spelling
Protection

Preferences

Ctri+F
Shift+Ctrl+F

mended tools for you
PDF [3 create PDF
d images fast. Fix a Quickly turn Microsoft Office
p an image. and other files into PDFs.
Use Now
NAME

L Script for Acrobat_Pitstop_PowerPoint Readme
PDF

jacow-collaboration
PDF

T

JACoW_LaTeX_A4
PDF

T

B JACOW.W10_A4

L PDF
F_ Changeloa
( General... Ctrl+K
g Enfocus PitStop Pro.. Alt+Ctri+K  ptep guide
T Enfocus StatusCheck...

document
PDF

E Editor Copmputer Setup
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2. General Settings

Stop Acrobat from generating URLs links in distilled papers. (Uncheck “Create links from URLs”)

pixels/inch

Preferences
Categories: Basic Tools
Commenting [ Usesi ey accelerators to access tools
Documents [] Create links from URLs
et & images
Make Hand tool read articles
03 [[] Make Hand tool use mouse-wheel zooming
Accessibility
Action Wizard [[] Make Select tool select images before text
Adobe Online Services Show quick actions on text selection
Cotalog [ show online st h ing fi
Color Management ow online storage when opening files
Content Editing Show online storage when saving files
Convert From PDF [[] Open PDFs from last session on Acrobat launch
Convert To PDF
Emnail Accounts Open documents as new tabs in the same window (requires relaunch)
Forms Prompt before closing multiple tabs
Identity - e
View Starred files in Recent tab
Internet
JavaScript
Language
. Lt < hot tonl i 1
Measuring (2D) [[J Use fixed £ P toplimages:
Measuring (3D) % N
~
Measuring (Geo) Enable PDF thumbnail previews in Windows Explorer
Mult!medfa &3D Touch Mode: | Auto-Detect v
Multimedia (legacy) .
Multimedia Trust (legacy) Scale for screen resolution (restart required): (@) Auto-Detect (O No Scaling
Reading
Reviewing
Search
Security
Sscurity (Enhanced) Warmings
Signatures
Spelling []Do not show edit warnings
Tracker
Trust Manager
Units & Guides Messages from Adobe
Updater Show me messages when | launch Adobe Acrobat
Application Startup
[[] Use only certified plug-ins Currently in Certified Mode: No
Piug
Select As Default PDF Handler
Tell me if Adobe Acrobat is not my default PDF application

Reset All Warnings
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3. Page Display

Display fonts using the fonts in the PDF not local fonts. (Uncheck “Use local fonts”)

Preferences

Categories:

Commenting
Documents
Full Screen

< Page Display )

Accessibility

Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)

Signatures
P

Default Layout and Zoom

Page Layout: | Automatic v Zoom: | Automatic ¥ |
Resolution

(O Use system setting: 96  pixels/inch (® Custom resolution: 10 5 pixelsfinch
Rendering

Smooth Text: | For Laptop/LCD screens J

Smooth images [[J Use local fonts

[J Use page cache

M Smooth line art

[ Enhance thin lines

Page Content and Information

[ Show large images [[]Use smooth zooming

[ Show art, trim, & bleed boxes [[] Show transparency grid
[ Use logical page numbers [] Always show document page size

Use Overprint Preview: | Only For PDF/X Files v Use Shift + Click For Multiple Selection with Output Preview

Default Transparency Blending Color Space: | Working RGB v

Reference XObjects View Mode

Show reference XObject targets: 70nly PDF/X-5 compliant ones =

Location of referenced files:

Browse for Location...

Cancel
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4.1 Content Editing
Make sure Adobe Acrobat displays this as they are. (Uncheck “Enable Artificial Bold/lItalic Styles”)

Preferences X

Categories: Default Editors for 'Edit Object Tool'

Commenting ~
Documents
Full Screen Image Editor...
General
Page Display
Page/Object Editor...
Accessibility
Action Wizard
Adobe Online Services Reading Order
Catalog
Color M o
Content Editing
ot N

Left to Right, Top to Bottom

Font Options

Convert To PDF
Email Accounts

Forms pr— :

Identity Default font for Add Text | Wingdings 3 ~ | FontSize
Intemet [ Enable Artificial Bold/Italic Font Styles

JavaScript

Language

Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Fallback font for Editing | Wingdings 3 vi ®

4.2 Content Editing
While editing if you accidentally type changing text in the PDF you may not notice, by setting the
editing text and add text to Wingdings 36 font size it will be obvious immediately

Preferences

Categories: Default Editors for 'Edit Object Tool'

Commenting ~
Documents

Full Screen

General

Image Editor...

Page Display
Page/Object Editor...
Accessibility

Action Wizard '
Adobe Online Services Reading Order

Latalog Left to Right, Top to Bottom

Content Editing

Font Options

Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

ck font for Editing | Wingdings 3 (0)

Default font for Add Text | Wingdings 3 ~| Font Size

[ Enable Artificial Bold/ltalic Font Styles

11|Page



5. Convert From PDF

Include all fonts during embedding. In the Encapsulated PostScript drop down menu “Font
inclusion” = Embedded and Referenced Fonts, Uncheck Convert TrueType to Type 1.
Preferences X

Categories: Converting From PDF

Commenting A ( Encapsulated PostScrip A PostScript level: 2 A
Documents Exc@ Binary: False

Full Screen H Preview: None

General % P 3 ] 3

Page Display PEG2000 < Font emitting: All fonts

—_— / PNG m

Accessibility PostScript Profife: Working CMYK

Action Wizard PowerPoint Presentatic Emit[CIDFontType2 as CIDFontType2: True

Adobe Online Services Rich Text Format Convrt TrueType to Type 1: False

Catalog Text (Accessible) Emit Lomments: False

Color Managemefit Text (Plain) Emit Halftones: False

C it TIFF Emit Jransfer Functions: True

< Convert From PDF D Word 97-2003 Docume Emit Undercolor removal: False
Word Document Overpfint: False

Email Accounts XML 1.0 i Emit Rgetness: True

Forms £ 2 Color: Composite v
Identity .- 3

Internet

JavaScript

Language

Measuring (2D)

Measuring (3D)

Measuring (Geo)

Multimedia & 3D

Multimedia (legacy)

Multimedia Trust (legacy)

Reading

Reviewing

Search o

oK Cancel

6. Identity

Place your name in the identity “Name” field which will be printed on the top of the page when you

print a dotted paper.

Preferences

Categories: Identity

Commenting ~ Login Name: IIPAC_PC1

Documents

Full Screen
General

Page Display Title: I

Accessibility Organization Name: ]

Action Wizard

Adobe Online Services Organizational Unit: I

Catalog

Color Management Email Address: ]

Content Editing

Convert From PDF Your identity information is used with comments, share, and digital signatures.

Convert To PDF
Email Accounts To change settings for Adobe online services, go to the Online Services preferences and click
Forms Manage Account.

|ntemg i

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Cancel
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7. JavaScript

JavaScript > Enable Menu Items > Check Enable menu items JavaScript execution privileges.

Preferences

Categories: JavaScript

Commenting "~ Enable Acrobat JavaScript

Documents

Full Screen JavaScript Securil

I Enabl items JavaScript execution privil
Page Display nable menu items JavaScript execution privileges

Enable global object security policy

Accessibility

Action Wizard JavaScript Debugger

Adobe Online Services

Catalog [[] Enable JavaScript debugger after Acrobat is restarted
Color Management Store breakpoints in PDF file

Content Editing

Convert From PDF PYQENESCE DRSO

Convert To PDF Ignore Trace Break

Email Accounts

Forms ] Enable interactive console

[[] Show console on errors and messages

Identity

Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)

Reading
Reviewing
Search

EEETa

Multimedia Trust (legacy)

JavaScript Editor

(® Use Acrobat JavaScript Editor
Font: | Courier New v

(O Use external JavaScript editor

8. Search

Configure the Acrobat search tool.

Preferences

Categories:

Search

Commenting
Documents
Full Screen
General

Page Display

Accessibility

Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

E—

[4] Enable auto complete suggestions
Highlight all matches
Ignore Asian character width

Ignore Diacritics and Accents

[ Always show more options in advanced search
Show document title in search results

Maximum number of documents returned in Results: {500

Range of words for Proximity searches: 900

Fast Find

Browse...

Fast Find makes future searches faster by storing information about Adobe PDF files that you use often.

Enable fast find
Maximum Cache Size: |100 MB
Purge Cache Contents

Cancel

Cancel
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9. Units and Guides
Setup the gridline which will show you the margin rules on the page. These are turned on and off

using Ctrl + U

Preferences

Categories:

Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)
Signatures

Spelling

Tracker

Units

Page & Ruler Units:

ayout Grid

Width between lines:
Height between lines:

Grid offset from left edge:

< Units & Guides DIV

Grid offset from top edge: |S4pt— :.:m
Subdivisions: |—1_ .:_
\ Grid line color: -] /
Guides
Guide color: [l
Rulers

[J Show rulers when opening documents

OK

Cancel
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10.1 Convert From/To PDF

Setup the PostScript/EPS to “JACoW 12” Template

Note: Before do this step must be setup the Adobe Acrobat Distiller DC first.

Preferer

Steps 1-6 lead to 7: Font emitting: All fonts

Converting From PDF

Categories:

3D & Multimedia

Accessibility

|Action Wizard

|Adobe Online Services

|Catalog

|Color Management

Content Editing

Convert From PDF e ]
|Convert To PDF
Email Accounts
Forms

|Identity

|Internet
|JavaScript

| Language

Measuring (20)
Measuring (3D)
\Measuring (Geo)
Multimedia (legacy)
[Multimedia Trust (legacy)
Reading

Reviewing

|Search

Security

Security (Enhanced)
|Signatures

|Spelling

Tracker

| Trust Manager

\Units & Guides

Encapsulated PostScri a
Excel Workbook

HTML

JPEG

JPEG2000

PDF/A

PDF/E

PDF/X

PNG

2 e POSESCIipt

PowerPoint Presentati
Rich Text Format

Text (Accessible)
Text (Plain)

TIFF

Word 97-2003 Document

Word Document \
< >

Save As Settings

General
Output
Marks and Bleeds
PostScript Options
Color Management

‘Updater
5
Categories: Converting To PDF
— A EMF A
3D & Multimedia HTHML
Accessibility JPEG
Action Wizard JPEG2000

Adobe Online Services g e
Catalog op —
Color Management

Content Editing

Convert From PDF 20 e
Convert T0 PDF < 1

Email Accounts

Forms

Identity

Internet

JavaScript

Language

Measuring (2D)

Measuring (3D)

Measuring (Geo)

Multimedia (legacy)

Multimedia Trust (legacy)

Microsoft 0ffice Exce
Microsoft 0ffice Powe
Microsoft 0ffice Proj
Microsoft 0ffice Visi
Microsoft 0ffice Word
Multimedia

PCX

PNG

PostScript/EPS

Text

TIFF

XPS

< >

Printer Description File:

~N

PostScript level: 3 ~
Binary: True

Pages: ALl

Font emitting: ALl fONtS ——
Transparency level: 100

Profile: Working RGB

Emit CIDFontType2 as CIDFontType2: True
Convert TrueType to Type 1: False

Emit Comments: True

Emit Halftones: False

Emit Transfer Functions: True

Emit Undercolor removal: False
Overprint: False

Emit Flatness: True

Color: Composite

Negative: False

e 4 GENETAL

Tranping: False ¥
< >
Edit Settings... 3
Device Independent v Defaults
6
Settings
(fJA§CII PostScript  Language Level 3
@ Binary

Font Inclusion: |Embedded and Referenced fFonts

None
M Include CommentsEmbedded Fonts

T R (Tt Croedded and Referenced Fonts

Click Edit Settings to view or edit settings for
this file type.

Steps 1-6 to be repeated for MS Word, Excel,
PowerPoint.

41—"—‘——————

Edit Settings...

Reading | Adobe PDF Settings for supporthd documents X
Reviewing 4 %
Search e
Security Adobe PDF Settings: “| | Eit...
Sgcurity (Enhanced)
Signatures Adobe PDF Security: MNone % Edit s
Spelling 6
Tracker CIAdd bookmarks to Adobe PDF file
Trust Manager
Units & Guides [JAdd links to Adobe PDF file
Updater IEnable accessibility andSreflou
/ 0K Cancel
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Categories: Converting To PDF

- Compuserve GIF - . " : - . -
3D & Multimedia EMF Click Edit Settings to view or edit settings for
Accessibility HTML this file type.
Action Wizard JPEG
Adobe Online Services JPEG2000
Catalog Microsoft 0ffice Exce
Color Management Microsoft Office Powe
Content Editing Microsoft 0ffice Proj
Convert From PDF Microsoft Office Visi
Convert To POF <——1 Microsoft Office Word
Email Accounts Multimedia
Forms PCX
Identity PNG
Internet PostScript/Eps =2
JavaScript Text
Language TIFF
Heasuring (2D) XPS v
Measuring (3D) < >
Measuring (Geo)
Hultinedia (legacy) Edit Settings... ™ >
Multimedia Trust (legacy) 4
Reading -
Reviewing Adobe PDF Settings X
Search
Security X .
Security (Enhanced) Adobe PDF Settings: - Edit...
Signatures
Spelling Adobe PDF Security: MNone - Edit...
Tracker
Trust Manager % _
Units & Guides 2 Cancel
Updater
0K Cancel
10.2 Convert to PDF
Setup the PNG Grayscale and Color to High Quality
Preferences X
Categories: Converting To PDF
Commenting ~ Adobe Formats ~ Monochrome Compression: JBIG2 (Lossless)
Documents Autodesk AutoCAD Grayscale Compression: JPEG (Quality : Medium)
Full Screen BMP Color Compression: JPEG (Quality : Medium)
General Compuserve GIF RGB Policy: Preserve emb 2
Page Display HIML Gray Policy: Off SeoheFas oo *
-— JPEG :
Accessibilty JPEG2000 Compression
Action Wizard Microsoft Office Excel Monochrome: ‘JBIGZ(LossIess) V‘
Adobe Online Services Microsoft Office Powe:

Catalog Mi(r?soﬁ.office Word Graysca JPEG (Quality : High) T
Color Management Multimedia /' A deie B
Content Ediing P> | — c,,. 7
< PNG —
[convert To POF ;
T Text v Color Management

< >
Forms RGB:  Preserve embedded profiles v F
Identity —— =

Internet | SRS | | “MYK: [ Not applicable v
JavaScript
Language
Measuring (20)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D "
Multimedia (legacy) oy Defaults Cancel |
Muttimedia Trust (legacy) )
Reading

Reviewing

Search

Grayscale:  Off v

Other: | Not applicable

oK [ Cancel
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11. Full Screen

Configure the Full Screen.

Preferences

Categories:

Commenting

Document
< Full Screen )
Page Display

Accessibility

Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Full Screen Setup
[ Current document only
[ Fill screen with one page at a time

[4 Alert when document requests full screen

Which itor to use:  This Moni v

Full Screen Navigation
[ Escape key exits
[ Show navigation bar

[ Left click to go forward one page; right click to go back one page

‘1 Loop after last page

!5 seconds

[[] Advance every

Full Screen Appearance

Background color: [l

Mouse cursor:  Hidden After Delay v

Full Screen Transitions

[ Disable all page transitions (e.g. auto-advance, slideshow, etc.)

Default transition:  No Transition v

Directiar - [ Navigation controls direction

Cancel
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Copy Doting Script to the correct Location

Place Dotting Script into ....... Directory, note the directory will be named the same as the version of
acrobat you are using.

I & 5 | AcrobatPitStopTools-master

= m] X
Home Share View 0
L v 4 I C:\Users\IPAC_PC1\Documents\JACoW Editor\AcrobatPitStopTools-master] ¥ |G O Search AcrobatPitStopTools-master
~
Name Date modified Type Size
# Quick access
IPAC JACoW Font 22 5:00 PM File folder
[ Desktop »* B
Notuse 22 5:00 PM File folder
& Downloads #2111 o Media Box 99:34PM Enfocus Action List 5KB
(& Documents 4 [ jACoW-09 99:34PM Adobe PDF Settings 14KB
=] Pictures # & 1acow-10 9/4/2019 9:34 PM Adobe PDF Settings 14KB
Ad JACoWSetDot 9/4/2019 9:34 PM JavaScript File 10KB
AcrobatPitstopTool || README 9/4/2019 9:34 PM File 3KB
| AcrobatPitStopTool Script for Acrobat_Pitstop_PowerPoint Re...  5/9/2022 11:02 AM Adobe Acrobat D... 35KB
@3‘ SplitAnimations 9/4/2019 9:34 PM Microsoft PowerP... 32KB
IPAC 22 IT Work
| @ SplitAnimations 9/4/2019 9:34 PM Microsoft PowerP... 545KB
[#] OneDrive
@ OneDrive
[ This PC
¥ Network

10items  1item selected 9.98 KB

Copy to local temp directory first

C:\Program Files\Adobe\Acrobat DC\Acrobat\Javascripts

< | Javascripts

Home Share View 0 ]

<« v 4 « Windows (C:) » Program Files » Adobe > AcrobatDC > Acrobat > Javascripts v O D Search Javascripts |
Name Date modified Type Size
s Quick access
2 \ le 2
I Desktop > debugger Ja/a?cnpt File 4 k'B
@ EnfocusSupport JavaScript File 3KB
¥ Downloads  # [ ssByteCodewin.bin BIN File 3,513K8
] Documents *
&= Pictures +
10.Adobe Acrobat F
AcrobatPitStopTool
Vi
IPAC 22 IT Work o) >
Sort by >
IPAC22_Software
Group by >
@ OneDrive Refresh
£ This PC Customize this folder...
= IPAC Software (E) paste [}
Paste shortcut
& Network Undo Copy Ctrl+Z
Give access to >
New >
Properties
3items
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Distiller Configuration
This will explain who to add the JACoW-12 options to the distiller etc.

Recently added

B Acrobat Distiller — O x
CamStudio X =
File = Settings Help
V& VNC Viewer Adi Font Locations... Crl+L
™ zoom i Watched Folders... Ctrl+F
Expand ¥ Edit Adobe PDF Settings... Ctrl+E
7 (;) Add Adobe PDF Settings... Ctrl+Shift+E
Remove Adobe PDF Settings... Ctrl+R
Ea 3D Viewer i
Prc Security... Ctrl+5
B -z Status Ready
Access Pause | |
Adobe Acrobat DC PDFFle | Sze |Tme |PSFle | Sze |[@ Settings | PDF Fold
e Adobe Acrobat Distiller DC
D Alarms & Clock
< >
R~
Calculator
/Osaka-MonoRoman ~
Frx] Calendar /Osaka-PropRoman
/RLKL-PropRoman
| R /Ryumin-Light-KL-PropRoman
/S MFix|
CamStudio 2.7 "/
]
"o m®
B 2dd Adobe PDF Settings X
A = » ThisPC » Documents v O Search Documents yel
Organize v MNew folder = [ @
& OneDrive ol MName Date modified Type Size
B This PC Custom Office Templates 4/25/2018 5:33 PM File folder
) 3D Objects
[ Desktop
|| Decuments
‘ Downloads
J) Music
&= Pictures
m Videos
= PCI9(\172.21.3
s Windows (T
s USB Drive (E:)
= pub (\\172.21.32
- YSB Drive (E:) v
File name: ‘ v‘ Adobe PDF Settings Files (*jobn ~
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<« v A > ThisPC > Documents > JACoW Editor » AcrobatPitStopTools-master v | O O Search AcrobatPitStopTools-...
Organize v New folder = ™M @
) Name 2 Date modified Type Size
> Quick access
IPAC JACoW Font 5/21/2022 5:00 PM File folder
[ Desktop * ~
Notuse 5/21/2022 5:00 PM File folder
¥ Downloads § 1acow-12 11/16/20239:34 PM Adobe PDF Settings 14K8
[Z Documents #
[&] Pictures *
A4
AcrobatPitStopT
AcrobatPitStopT
IPAC 22 IT Work
[#Z] OneDrive
@ OneDrive
[ This PC
=¥ Network >4
File name: | JACOW-12 v ‘ | Adobe PDF Settings Files (*,jobr v |
‘ Open ‘ ‘ Cancel ‘
B Acrobat Distiller - | X B Acrobat Distiller — O *
. . [
File Settings Help " File Settings  Help
—Adobe PDF Settings Open... Ctrl+Q  }
Defaut Setings: 5
N Preferences... Ctrl+K
Compatibilty:  Acrobat 7.0 (PDF 1.6) F16)
Setup for JACoW - paper size, embed all fonts, compression, Acrobat 7 Exit Ctrl+Q hed all forts. compression, Acrobat 7
Q compatibility . ¥
— Progress - Progress
Status: Ready Status: Ready
Pause | LCancel Job | Pause LCancel Job
PDF File Size Time | PS File Size & Scitings | PDF Fold PDF File Size | Time | PS File Size Settings | PDF Fold
!P_‘
24
< 3 < >
/Mot DetFont
/Osaka-MonoRoman A =
ok ogionn et
/RLKL-PropRoman "
/Ryumin-Light-KL-Prop Roman /RLKL-PropRoman
/S MFx /Fyumin-Light-KL-Prop Roman
/SMFix|
w v
T
Preferences - Acrobat Distiller X

~ Startup Alerts

[V Notify when Watched Folders are unavailable
IV Notify when Windows TEMP folder is neary full

~Output Options
[V Ask for PDF file destination

[V 4sk toreplace existing PDF file

¥ View PDF when using Distiller

i~ Log Files
¥ Delete Log Files for successful jobs

~ Security
[ Trust allfiles opened via Acrobat Distiller

These preferences control the Distiller application. For Adobe PDF
Printer settings, right-click the Adobe PDF printer and choose Printing
Preferences or Document Defaults.

Qo

20| Page



Adobe Printing Configuration

Access the Control Panel\All Control Panel Items\Devices and Printers and Right click the Adobe PDF

> Printing Preference

Settings

[}Q Adobe PDF

Manage your device

Printer status:  Default

Open print queue Set as default
Print a test page

o Adobe rint
Run the troubleshooter

Layout Paper/Quaity [lll Adobe PDF Setings

Printer properties oE ’

Setup for JACoW - paper size, embed all fonts, compression, Acrobat 7 compatibility.

Printing preferences

Hardware properties

Defaut Setings: [JACOW-12

~] Edi..

Adobe PDF Securiy: |None

Adobe PDF Output Folder |Prompt for Adobe POF filename

=] _ oo |

Adobe PDF Page Size: [A4
] View Adobe PDF results
] Add document information

e ] Rely on system fonts only; do not use document fonts

F7] Delete log fles for successful jobs

] Ask to replace existing POF file

= Adobe PDF

Manage your device

Printer status:  Default

Open print queue Set as default
Print a test page

Run the troubleshooter

Layout PaperiQuaity [Jl] Adobe POF Setings

Printer properties Tray Selection

Paper Source:
Printing preferences

. Colour
Hardware properties

g (O Black & Whit

Adobe PDF Converter Advanced Options

Automatically Select v

a ® Colour

= Adobe POF Converter Advanced Document Settings
=+« Paper/Output

A -———
Copy Count: 1 Copy
mGraphic
Print Quality: 1200dpi
© Inage Colour Management
ICH Method: ICM Disabled
ICH Intent: Pictures
Scaling: 100 %

=% Document Options
-Pu%rinl Options
TrueType Font Download Option: Mative TrueType
PostScript Language Level: 3

Send PostScript Error Handler: Yes
Mirrored Output: No

e

TrueType Font: Dowunload as SOfLfONt gue—

PO Script Output Option: Optimize for Portability

Paper Sizé doesn't matter as it
is set above in Paper Source as
Automatically Select

Advanced. ..

Cancel  Appy

\%
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Word 365 Configuration

Info

Acrobat 2017 Setup

Open 2 Docs = Setups
Save Protect Document Properties ©
Control wht types of changes people can mske 10 this documant size
e Protect .
Document - oges

Wiards

Total Editing Time

itle
o Inspect Document —
Li Befare publishing this fie, be sware that i cantains: L'* =
o = Document prapetis, suthors name and crapped aut image dets et
Share ssues - o
T Characters formatted as hidden text Related Dates
s Custom XML data Last Modified Taday, 11:53 AM
- Cantent that people with disabltes are unabe ta read o T
Last Printed
. Manage Document R
Account Q Checkin, check out, and recover unsaved changes. et ple
Manage ) There are no unsaved char Auther
Optian: Document = | | 1% € P unsaved changes. Windows User
Add an autho
Last Mdified By
‘Windows User

Related Documents

Open File Locatior

Show Al Properties

Word Options ? *
¥ UPTAETE qoCURTEnT CONTEnT WHITE araggimng N
General . L
| Use subpixel positioning to smooth fonts on screen
Display
X Print
Proofing
Save Use draft guality
| Print in background G
Language ) )
Print pages in reverse order
FEEER Print XML tags
Customize Ribbon Print field codes instead of their values
Quick Access Toolbar | Allow fields containing tracked changes to update before printing
Print on front of the sheet for duplex printing
Add-ins . A
Print on r duplex printing
Trust Center [ Scale content for A4 or 8.5 x 11" paper sizes
Default tray: | Use printer settings =
When printing this document: | Acrobat 2017 Setup v
Print PostScript over text
Print only the data from a form
Save
Prompt before saving Mormal template G
Always create backup copy
Copy remotely stored files onto your computer, and update the remote file when saving
| Allow background saves
Preserve fidelity when sharing this document: Wi Acrobat 2017 Setup v
Save form data as delimited text file
/| Embed linquistic data -
QK Cancel
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Word Options

G | .

sner E-E Customize the Ribbon and keyboard shortcuts.
Display
Sroofi Choese commands from: (D

reenng | Popular Commands A
Save
Language Accept Revision z

T2 Add Table 3

Advanced Align Left

Bullets 4
Center
Change List Level L4

| Customize Ribbon_>

Quick Access Toolbar

Add-ins
Define Mew Mumber Format...

Delete

Draw Table

Draw Vertical Text Box
Email

Find

Fit to Window Width
Font

Font Color

Font Settings

Font Size

Footnote

Format Painter

Grow Font
Hyperlink...

Insert Commment
Insert Page Section Breaks L4
Insert Picture

Insert Text Box

Trust Center

Keyboard shortcuts:

Customize the Ribbon: @
Main Tabs

Main Tabs

Home

[+]

Insert

Design
Layout
References
Mailings

L]

Insert (Blog Post)
Outlining

Background Remaoval

Mew Tab | | New Group ‘ | Rename... |

Import/Export ¥ |©

Now will have Development Tab on the Ribbon.

B ©- Acrobat 2017 Setup Under ]
File Home  Inset  Design  layout  References  Mailings  Review  View [EVCIOECISEN  ACROBAT  Q Tellmew
Qj D .JRecord Macro a o3 Aa A3 = % gDswgn Mode @ D
Ly Pause Recording o o EQERE [E Properties
Visual Macros . Add-  Word COM = — XML Mapping Elock Restrict |Document
Basic ¥ Macro Security ins  Add-ins Add-ins ,—_|ﬂ-i' <& Group Pane Authors - Editing | Template
Code Add-ins Controls Mapping Protect Templates
L 1 | -E-‘-l---1-‘-|--‘1-‘-|--‘3-‘-|--‘4-‘-|--‘5-‘-|--‘6-‘-¢- 7
Templates and Add-ins ? x
Templates XML Schema XML Expansion Packs Linked C55
Document template
|Nulmal |¢ Attach... D
|:| Automatically update document styles
Attach to all new e-mail messages
Global templates and add-ins
Checked items are currently loaded.
Add..
Full path:
ok | cancel
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From https://github.com/JACoW-org/JACoW_Templates/tree/master/MSWord/A4

Attach Template X
« v » ThisPC » Desktop » Editor » ~ | B Search Editor 2
Organize + Mew folder B== ~ [N o
m Microsoft Word Name Date modified Type Size
. Thursda 4/27/2018 9:06 AM File folder
¢ OneDrive
0| JACOW_W16_A4 4/26/20185:58 PM  Microsoft Word T... 6,962 KB
[ This PC
ZJ 3D Objects
[ Desktop
Documents
‘ Downleads
J'i Music
[&] Pictures
{8 videos
= PC19(\172.21.3
e Windows (C:)
= pub (\\172.21.32
=% Network v
File name: | JACOW_W16_A4 v| |AII Word Templates V|
Tools - | Open | ‘ Cancel |
Word Options ? X
General ; =
Customize how documents are saved.
Display
Proofing Save documents
Save S <o X | * ]
ave files in this format: | Word Document (*.docx) X
Language Save AutoRecover information every | 5 2| minutes
Accessibility [] Keep the last AytoRecovered version if | close without saving
Advanced AutoRecover file location: |C:\Users\IPAC_PC1\AppData\Roaming\Microsoft\Word\ Browse...

Customize Ribbon
Quick Access Toolbar
Add-ins

Trust Center

[C] Don't show the Backstage when opening or saving files with keyboard shortcuts
[/] Show additional places for saving, even if sign-in may be required.
[[] Saveto Computer by default

Default local file location: lC:\Users\IPAC_PC1\Documents\

| | Browse...

Default personal templates location: i

l

Offline editing options for document management server files

Saving checked out files to server drafts is no longer supported. Checked out files are now saved to the Office
Document Cache.

Leam more

Server drafts location: |C:\Users\IPAC PC1\Documents\SharePoint Drafts\

 fidelity when sharing this document: | 8] All New Docume

[4] Embed fonts in the file (i)
[EJEmbed only the characters used in the document (best for reducing file size)l

[l Do not embed common system fonts

Days to keep files in the Office Document Cache: | 14 +
[T Nalete filac from tha Offica D, + Cach,

whan theu ara clocad

| ok

|| Cancel [
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1. Enable editing in word by default

Access the menu File > Option > Trust Center > File Block Setting to check”Open selected file types
in Protected View and allow editing” then click “OK”

TUZPLM1

ol General
‘—\‘-‘ Help keep your documents safe and your computer secure and healthy. S
Paste Display Request ft 365
A Proofing Security & more pignatures
Clipboard bat A
Save Visit Office.com to learn more about protecting your privacy and security. 6. . nvited
Navig | Langusge Microsoft Trust Center hft 36
Search 1| Accessibility c
s Microsoft Word Trust Center
Advanced E TO OUR
Heading The Trust Center contains security and privacy settings. These settings help keep your _—
Customize Ribbon computer secure. We recommend that you do not change these settings. Trust Center Settings... |
Quick Access Toolbar g
In Trust Center ? X
G| Add-ins
Trusted Publishers
d3 | Trust Center s ECLuREen File Block Settings
A Trusted Locations
* For each file type, you can select the Open and Save check boxes. By selecting Open, Word blocks this file type, or
Trusted Documents opens it in Protected View, By selecting Save, Word prevents saving in this file type.
C T
Trusted Add-in Catalogs File Type Open__JSave
A Word 2007 and later Documents and Templates 1} ]
R Add-ins OpenDocument Text Files O
ActiveX Settings Word 2007 and later Binary Documents and Templates O
Macro Settings Word 2003 Binary Documents and Templates
Word 2003 and Plain XML Documents [
Protected View
PR Word XP Binary Documents and Templates
Message Bar Word 2000 Binary Documents and Templates
I File Block Settings Word 97 Binary Documents and Templates O
4—%&(? p— Word 95 Binary Documents and Templates Q\
Word 6.0 Binary Documents and Templates ]
Form-based Sign-in Word 2 and earlier Binary Documents and Templates =
Web Pages O O
RTF Files O (|
Page 1 of BI7TYWOTaS & ENgISTA Plain Text Files | O
Legacy Converters for Word | O
Office Open XML Converters for Word 5 | O
PDF Files ||
Open behavior for selected file types:
Do not open selected file types

Open selected file types in Protected View

© |Open selected file types in Protected View and allow editing|

‘ Restore Defaults
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PowerPoint 365 Configuration

Presentation] - PowerPoint Signin & 2 - s] X
Good evening
~ New
[ New
- — - - - @ ﬂ ;ri“c =
psum
Info <2 al AN
Blank Presentation ‘Welcome to PowerPoint Bring your presentations to ... Pantone Color of the Year 20... Geometric color block Urban monochrome
Save
Save As More themes —>
Save as Adobe
PDF Recent  Pinned
You haven't opened any presentations recently. Click Open to browse for a presentation.
More presentations —>
Account
G
PowerPoint Options ? X
| 3 X A = $
Genen) [L' View and manage Microsoft Office Add-ins.
Proofing
Save Add-ins
Language |Name ~ | Location | Type
Accessibility ‘A(tive Application Add-ins ) )
'Acrobat PDFMaker Office COM Addin C\...Maker\Office\x64\PDFMOfficeAddin.dll COM Add-in
Advanced Foxit PDF Creator COM Add-in C:\...gins\Creator\x64\FPC_PPTAddin_x64.dll COM Add-in
5 PPsphiT CA\...Microsoft\AddIns\PPspliT\PPspliT.ppam PowerPoint Add-in
Customize Ribbon
WSS Toolbar Inactive Application Add-ins
OneNote Notes about PowerPoint Presentations  C:\..ft Office\root\Officel6\ONPPTAddin.dll COM Add-in
(‘Add-ins )
Document Related Add-ins
TrosrCent 3
No Document Related Add-ins
Disabled Application Add-ins
No Disabled Application Add-ins
Add-in: Acrobat PDFMaker Office COM Addin
Publisher: Adobe Inc.
Compatibility: No compatibility information available
C\Program Files\Adobe\Acrobat DC\PDFMaker\Office\x64\PDFMOfficeAddin.dll
D Acrobat PDFMaker Office COM Addin
Manage: |\ owerPoint Add-ins Il { Go...
> | OK I l Cancel |
Lo o s
Disabled ltems I = .
ility: Good to go = Notes ¥® Comments =N S
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Add-ins

Ayailable Add-ins:

Load
[ pespiit

@ Add New PowerPoint Add-in

& v A | | > IPAC Software (E:) » IPAC22ITWe(k » AcrobatPitStopTools-master »

Organize v New folder

A Name Date modified Type
#* Quick access

[ Desktop o
& Downloads #
[::] Documents
[&] Pictures »*
10.Adobe Acrob
AcrobatPitStopT

| IPAC 22 ITWork

. IPAC22_Software

¥ 5/10/2022 11:14 AM File folder
@l SplitAnimations

@ Microsoft PowerP
@ OneDrive

[ This PC

— IPAC Software (E) ¥

File name: | SplitAnimations

9/4/2019 9:34 PM Microsoft PowerP...

0

o /2 Search AcrobatPitStopTools-...

E~y M @

Size

32 KB

Y

-ins v l

SN
@I\P" | | Qe |
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Microsoft PowerPoint Security Notice ? X

@ Microsoft Office has identified a potential security concern.

Warning: It is not possible to determine that this content came from
a trustworthy source. You should leave this content disabled unless
the content provides critical functionality and you trust its source.

File Path: |E:\IPAC 22 IT Work\AcrobatPitStopT ools-master
\SplitAnimations.ppa

Macros have been disabled. Macros might contain malware or other
security hazards. Do not enable this content unless you trust the
source of this file.

More information

l Enable Macros D[gisable Macros |

Add-ins ? X

Available Add-ins:/ [ Vgoz.»d

[ pespiit = ‘
'@|¥% SplitAnimations Lg&f
| Add New... |

[ Remove

Enfocus PitStop 21.3.0 Activation Process

Select the menu Help > About Third-Party Plug-Ins > About Enfocus PitStop Pro.
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Adobe Acrobat Pro DC (64-bit) - [m] X
File Edit View gn Certified PDF PitStop Pro  Window  PitStop Pro D;:w
Home  Tools T (©) Sign In
Recent
Recommended tools for you elp " All Tools .
Starred N Get documents signed fast
0 = o Get document
52 EditPOF hbine Files
DOCUMENT CLOUD trusted e-signat
t Fixa
»
Al files
Scans ‘
Shared by you Generate System Report...
Recent Repair Installation M
Shared by others
Check for Updates... b
OTHER STORAGE
Script for Acrobat_Pitstop_PowerPoint Readme - S =
My Computer POF R
Add an Account jacow-collal T P 26 KB
PDF o B -
SIGN JACOW_LaTeX_A4 s o e
; N o G
All Agreeme ©
CoW_W10_A4 - et -
L Today, 5:34 P B
Changelog =
PDF ‘ A
= Processing transparencies - a step-by guide - _ e
_— PDF N - - -
document 2
= POF 2
Editor Copmputer Setup 2 o =l = ¥
Clear Recent

Select “Offline Activation”

About License Support info

Preflight your way
1f you don't have internet access, you can continue with offline activation.

If you have a subscription, pleass go online and you will see a sign in sareen appeanng. Sign in with your
Enfocus ID to start your subscription,

Offline Activation

Try Again Edit Proxy Settings...

Contact a System Administrator to edit
your Proxy Settings.

PITSTOP

PRO
2022

Start Triad Buy/Subscribe...

ENFCCUS

1 should be online again by now, try again
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Click “Start Trial.”

About Enfocus PitStep Pro

About License Support info

Preflight your way

Offline activation mode: In case you would ike to start a subscription, this will not work.

S@aft Trial Activate Key

PITSTOP

PRO
2022

ENFCCUS

1 should be online again by now, try aqain

Enter the Enfocus ID then click “Start Trial.”

About Enfocus PitStep Pro
About License Support info

Preflight your way

Enter your Enfocus ID to start your trial

B D e e \.I

PITSTOP

PRO
2022

ENFCCUS
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Save the Request Activate file to computer.

Q Acrobat

Step 1: Create Activation Request

Step 2: Load Activation Response

Please save or drag and drop this activation request and upload it to the Enfocus

Please load, or drag and drop the activation response into this panel.
activation website on a computer that has an internet connection.

http:/fwww.enfocus. com fproductsfactivationlang=enUS

This is the file you received from the Enfocus activation website during Step 1.

You will receive an activation response which you should load in the right-hand

Then dick Activate to complete the activation process.

panel: Step 2
requestactivate.xml
Q Acrobat
Save File

A [E > ThisPC > Documents »

Organize v New folder
A Name & Date modified
o Quick access
. download_wmm 5/11/2022 1:34 PM
[ Desktop * f
G aker 5/10/2022 1:23 PM
f Downloags™ o [] requestactivate 5/11/2022 &:41 PM
& Doc ' R
= Pictures *
. 10.Adobe Acrob
IPAC 22 IT Work
IPAC22_Software
D Music
@ OneDrive
= This PC
v

File name: | requestactivate

X
v 0 O Search Documents
Ezv @
Type Size
File folder
File folder
XML Document 3KB|

Save as type: | Request Files (*xml)

A Hide Folders
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Click a link to offline activation webpage. Then Browse to activate request file at local folder.

Q Acrobat

Step 1: Create Activation Request

Please save or drag and drop this activation request and upload it to the Enfocus
activation website on a computer that has an internet connection.

e

You will receive an activation response which you should load in the right-hand
panel: Step 2

requestactivate.

@ Offline activation | Enfocus X | +

Step 2: Load Activation Response

Please load, or drag and drop the activation response into this panel,

This is the file you received from the Enfocus activation website during Step 1.

Then dick Activate to complete the activation process.

= [} X
@ O 6 https://www.enfocus.com/en/support/licensing-and-activation/offline-activation?lang=enUS Q =
A
Home > Support > Licefising & activation > Offline actival
@ File Upload X
OI "Ine Ctiv 4 [£ > ThisPC > Documents » v o Search Documents
Here you can ugjbad the request{ Organize ~ New folder B @ ©
A Name - Date modified Hpe Size
i # Quick access
We will gegferate a response file o - download_wmm 5/11/2022 1:34 PM File folder
eskto
-ﬂ —SoteTaRer : File folder
,,,,,, $ Dow/EAE O ustadivm 5/11/2022 445 PM XML Document 3K8

Documents

&= Pictures *
Continne 10.Adobe Acrob.
‘\ IPAC 22 1T Work

PAC22_Software.
D Music

@ OneDrive

[ This PC

- [PAC Software (E:)

¥ Network X

File name: | requestactivate

s .
T Dt |
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Enter Enfocus E-mail and Password that was registered.

@ Ofiline activation | Enfocus X | + = [m] X

<« C ® O 8 o htps

vww.enfocus.com/en/support/licensing-and-activation/offline-activation?lang=enUS W @ =
ENF@CUS

Home > Support > Licensing & activation > Oifline actvatior
Offline activation

E-mail chaypreecha. 2124@gmail cc

Password [ ececccce

Forgot your Password? !
| Continue ’

Then click “Continue” to activate program.

ENF@CUS

Home > Support > Licensing & activation > Oifline activatior
Offline activation
The activation request you submitted is for the following product.

PitStop Pro 2022 (Trial) [N
PPRsg2-YATAAS-1aDGgl-BANQu9-7b8c3C

If this is the product you wish to activate. click Continue.
If this is not the product you wish to activate, click Previous and upload an other activation request file.
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After registering, download the registration file.

@ Offline activation | Enfocus X + = [m] X
<« C @ O 6 https://www.enfocus.com/en/support/licensing-and-activation/offline-activation?lang=enUS Lk d Y =
~
D activation-responsexml o
ENF@CUS Completed — 5318
Home > Support > Licensing & activation > Offline activatior Show all downloads

Offline activation

You have now leted the y steps for uploading the activation request file.

Nownload

To finalize the activation, you need to load the activation response file you downloaded from this page in the Activate License Wizard. This will activate your license.
Return to the activation options

PPRsg2-YATAAS-1aDGgl-BANQu9-7b8¢3C
PitStop Pro 2022 (Trial)

Load Activation Response file.

@ Acrobat ? X
Step 1: Create Activation Request Step 2: Load Activation Response
Please save or drag and drop this activation request and upload it to the Enfocus Please load, or drag and drop the activation response into this panel,

activation website on a computer that has an internet connection.

http:, 7 R 7 !
/(v et o e u e ek This is the file you received from the Enfocus activation website during Step 1.

You will receive an activation response which you should load in the right-hand
panel: Step 2
Then dick Activate to complete the activation process.

requestactivate.xm!
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‘i Acrobat

Open File

™ ‘—ﬁ > ThisPC > Documents >

Organize v New folder

A Name

A Quick access
I Desktop »*
& Downloads #
[5] Documents #
[&=] Pictures *
_ 10.Adobe Acrob
| IPAC 22 IT Work
IPAC22_Software
D Music

. download_wmm
| Sof
Vadwatio‘nmm‘lse

@ OneDrive
This PC
s |PAC Software (E:)

b Network b

v o o]

Date modified Type Size
5/11/2022 1:34 PM
5/10/2022 1:23 PM
5/11/2022 451 PM

5/11/2022 4:50 PM

File folder
File folder
XML Document
XML bocum:ni

6KB|
3KB

File name: | activation-response

\j | Response Fl|; i;.xml) v |

i

% Acrobat

Step 1: Create Activation Request

Please save or drag and drop this activation request and upload it to the Enfocus
activation website on a computer that has an internet connection.

http: //www.enfocus.com/products/activation?lang=enUS

You will receive an activation response which you should load in the right-hand
panel: Step 2

requestactivate.xmi

I Open I Cancel

|
%

Step 2: Load Activation Response

Please load, or drag and drop the activation response into this panel,
This is the file you received from the Enfocus activation website during Step 1.

Then dick Activate to complete the activation process.

activation-response.xml

.
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Finish.

About Enfocus PitStop Pro
About License Support info
Preflight your way

1f you don't have internet access, you can continue with offline activation.

If you have a subsaription, please go online and you wil see a sign in sareen appearing. Sign in with your
Enfocus ID to start your subscription.

Try Again Edit Proxy Settings... Offline Activation

Contact a System Administrator to edit
your Proxy Settings.

PITSTOP

PRO
2022

You can now use Enfocus PitStop Pro for e Buy/Subscribe
31days : = s

ENFOCUS

1 should be online again by now, try agan

=]
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Load Enfocus PitStop JACoW Media Box
Select menu PitStop Pro > Action Lists.

(%) IPACT9ITSetupReport.pdf - Adobe Acrobat Pro DC (64-bit) - [u] X
File Edit View E-Sign Certified PDI indow _PitStop Pro Dashboard  Help
Home  Tools IPACIOIT  Object » @ A signin
[a {:f {1:) B Q Preflight Alt+Ctri+P @ @ 204% -~ @ - ? s é. E G.
- Global Changes Alt+Ctri+G —_—
Alt+Ctrl+A AN @
QuickRuns
QuickRun Favorites »
Navigator...

Object Browser...

Variable Sets 4

Typical daily bandwidth

¥ isEs.uxzazcaesHEEREEEGEEDR

Select menu Local > Import/Export > Import

[® 1PAC1ITSetupReport.pdf - Adobe Acrobat Pro DC (64-bit) = ] X
File Edit View E-Sign Certified POF PitStopPro Window PitStop Pro Dashboard Help

Home  Tools IPAC19ITSetupRep... % @ A signin

BYXY®B QOO 72/ MO nx- @A P o G = e

~
Action Lists

v|[el @~

Q
23
ca
| oy A @
b
B
£

Export Group...

Typicaldailyk “E=>" =

O
¥ <
Run on:
e
Complete document v =
All pages v AR mE_Me—mmEmsnas

12 2| pages from current page E- - — — O

Sl ml s ow s 2 (eg: 1-10,15,20-) ’

Show results (]
B
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Locate file and click “Open.”

® 1PACISITSetupReport.pdf - Adobe Acrobat Pro DC (64-bit)

- 0 x [
File Edit View E-Sign Certified PDF PitStopPro Window PitStop Pro Dashboard Help
Home  Tools IPAC19ITSetupRep... X @ A signin
AcrobatPitstopTools-master > vio
()
BAX®B QOO 7/ A MO - B P oo a =2 e
= Date modified Type Size
| sno02 4 am File folder
Action Lists 9/4/20199:34PM Enfocus Action List 5K8
9/4/2019 9:34 PM Adobe PDF Settings 14KB
9/420199:34PM Adobe PDF Settings 14K8
9/4/2019 9:34 PM JavaScript File 10K8
9/4/20199:34PM File 3K8
5/9/2022 11:02 AM Adobe Actobat D... 35K8
9/4/20199:34PM Microsoft PowerP... 32K8
/412019 9:34 PM Microsoft PowerP.. 545 K8
Typical daily k i
p y « v 4 |1 CPAC Software (E:) > IPAC 22T Work »> Acrabdwhs@ v oo O Search AcrobatPitStopTools-...
Organize v New folder W @
A Date modified Type Size
# Quick access
5/10/2022 11:14 AM File fold:
Ws 2 /107 N e folder _
9/4/20199:34 PM Enfocus Action List 5K8
& Downloads #
> [ Documents #
(&) Pictures  # |
|| 10.Adobe Acrob -
| | IPAC 22 1T Work |
[ ] 1PAC22_Software.
D Music
f30 nip s ey @ OneDrive
L bh
B This PC
= IPAC Software ()
| = Network ¥
File name: [JACoW Media Box | [Enfocus ActionLists (neal) |
Open ] Cancel
Finish.
9ITSetupReport.pdf - Adobe Acrobat Pro DC (64-bit) - ] X
File Edit View E-Sign Certified POF PitStop Pro Window PitStop Pro Dashboard Help
Home  Tools IPAC19ITSetupRep... X @ A signin
Bx®B8 QOO 7/2= MM OO n=- o Ga X e
7 T
~ Q
Action Lists
I B
vllel[#]l¥] @s=a
2
ﬁ Favorites ¥
Recent
> |& Standard E
v @
") JACoW Media Box @
Typical daily k
: B
b
Ce
» 4

) pages from aurrent page

i -
Teal mE;E (Te 1905458 0w 30 viGH

| teg: 1-10,15,209

e
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MikTex Console Configuration

- K-Lite Lodec Pack
New

Productivity

LibreOffice 7.3 ~ ‘

Microsoft Edge Firefox
Mail

Maps
MaxxAudioPro
Opera Browser

¥ Microsoft Edge

- Microsoft Office Tools

u Microsoft Store

T“‘ Microsoft Teams VQ
< Ne

VNC Viewer
Bl vikrex

W&y MiKTeX Console

S TeXworks

& \tixed Reality Portal §c

- Double
"B Movies & TV Commander

N

B Notepad++
»P O O m @

MiKTeX to be installed in "User mode" (not “Admin mode”) because "Admin Mode" leads to
package load errors and a mix-up when users are not logged in as Administrators and the flag on

“Always” is not set correctly (which requires Admin privs when installing).

2 MiKTeX Console

File Tasks Help

Welcome!

Operation mode

This is MiKTeX Console. The program will assist you in managing your MiKTeX configuration.

If you want, you can start with an online tutorial: HOWTO: manage MiKTeX with the MiKTeX Console

Please decide how you wish to continue:

— Switch to MiKTeX administrator mode
Restart MiKTeX Console with elevated privileges and switch to MiKTeX administrator mode.
Use this option, if you want to operate on the shared (system-wide) MiKTeX configuration.

J —> Stay in MiKTeX user mode
5 Continue to work with MiKTeX Console in MiKTeX user mode.
Use this option, if you want to operate on your own MiKTeX configuration.
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Select “Settings”

@ MiKTeX Console - m] X
File Tasks Help

Settings
Overview
General Directories Formats Languages

Updates

User interface

Documentation

Language: <System Language> ~
Packages

Package installation
Diagnose

Packages are retrieved from: <Random package repository on the Internet> Change...
fren You can choose whether missing packages are to be installed automatically (on-the-fly):
Settings ® Always =

For anyone who uses this computer (all users)

(O Ask me

'y O Never
Paper format

Select your preferred paper format: A4

1 )
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Enable the built-in PDF viewer

You can also set a PDF viewer to handle PDF files. To switch from using another viewer to the built-in

PDF viewer:

PwnNPE

Click the menu button =and select Settings.

In the General panel, go down to the Applications section.

Find Portable Document Format (PDF) in the list and click on the entry to select it.
Click on the arrow under the Action column for the above entry and select the Open in

Firefox from the drop-down menu.

@3 Settings

O (@ @ Firefox

@3 General
@ Home
Q Search

& Privacy & Security
Q Sync

m More from Mozilla

ﬁ Extensions & Themes

@ Firefox Support

Other References

e  https://www.jacow.org/

x

+ —

about:preferences w

2 Find in Settings

Applications
Choose how Firefox handles the files you download from the web or the applications you use while

browsing.

| 2 Search file types or applications

. Content Type - | Action
[& AV1 Image File (AVIF) @ Openin Firefox
|7 Extensible Markup Language (XML) ¥ SaveFile
mailto [ Use Mail (default)

Portable Document Format (PDF)
€ Scalable Vector Graphics (SVG)
€ WebP Image

“% Open in Firefox
Open in Firefox
[Z Always ask

. Save File

[T Use Windows default application

Use other...

e https://www.jacow.org/Editors/AllThingsIT

e https://www.jacow.org/Editors/RecommendedSoftware
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